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Welcome and thank you for using Strategy Runner’s Strategy Automation Station (SAS), 
formerly Third Party Automation Kit (TPAK). 

SAS transmits your trading signals, generated by TradeStation, Excel, Wealth-Lab, 
Collective2 and proprietary applications into actual orders on your live account.  

SAS can also be utilized in order to penetrate a raw API, via Strategy Runner (SR) Client 
Side (CS) API.  

SRCSAPI is an integral part of SR Strategy Automation Station (SAS). Its purpose is to 
provide easy to use interface that allows trading system developers to have complete 
control over their strategies. 

 

Let’s start with a basic overview of how SAS works. 

1) TradeStation and SAS are both running on your personal computer (PC). 
TradeStation is configured to send email notifications for every trading signal that 
your strategy originates, fills, or cancels a trade.  

2) SAS intercepts these trading signals and then sends them to the SR server(s) at the 
brokerage of your choice that connects to your live account.  

3) The SR server(s) then executes these trading signals for your live account (or 
multiple accounts that are signed up to receive them). 

 
 

 
Figure �1-1: The STRATEGY AUTOMATION STATION flow:  

(1) TradeStation & STRATEGY AUTOMATION STATION � (2) Strategy Runner servers at your 
brokerage � (3) live account(s) 
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To proceed with installation and setup see �Chapter 2: Installation and �Chapter 3: Quick 
Setup Guide. To conduct live trades you will need a brokerage account with one of our 
affiliated partners. Please see http://www.strategyrunner.com/Content/Partners.html for a 
list of brokerages that support SAS. 

To proceed to documentation about SAS Client Side API, please see Appendix in 
Chapter 6. 
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Installation Requirements 
Make sure your computer meets the following requirements: 

• Microsoft .NET frameworks installed  
• Win2000/XP 
• 256 megabytes of RAM (in general 512 megabytes is recommended) 
• At least Pentium III or equivalent 
• 56k dialup internet connection (in general broadband with 256k recommended). 

Downloading and Installing the Program 
To download and install Strategy Runner Strategy Automation Station: 
Go to http://www.strategyrunner.com/Content/Downloads.htm and click the link for 
Strategy Automation Station. Follow the Installation instructions. 

Running the Program for the First Time 
To run Strategy Automation Station: 

Connect to the Internet. 
Go to Start�Programs�StrategyRunner�Strategy Automation Station� Strategy 
Automation Station 

The Main Window 
After you start the program, the main window opens, displaying your portfolio (see 
Figure �2-1).  

The window is divided into the following areas: 

No. Area Purpose 
1 Menu Bar Includes menus for managing the product's 

main functions. 
2 Toolbar Includes icons for quick access to the product's 

most frequently used functions. 
3 Strategies table  Lists the current strategies in your portfolio and 

their details. 
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No. Area Purpose 
4 Signal Logs Tab Lists sent orders. 

5 Messages Tab Lists the messages about various events. 

Table �2-1: The Main Window Explained 

 

 

Figure �2-1: The Main Window 

Menu Bar 
The Menu Bar includes menus for managing the product’s main functions. Using the 
menus you can: 

• Save, download and upload your portfolio. 

• Manage strategies and resources. 

• Set and modify system options. 

 

3 

      5  

 

4 

1 

2 
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Toolbar 
The toolbar comprises icons for quick activation of the most often used product’s 
functions. 

•  Save Portfolio. 

•  Add Strategy. 

•  Delete strategy. 

•  Run Strategy. 

•  Stop Strategy. 

•  Liquidate Strategy. 

•  Upload Portfolio to Server(s).  

•  Download Portfolio from Server(s). 

•  System Options. 

•  Help. 

•  Messages. 

•  Problem Report. 

The Strategies Table 
The Strategies table displays all the strategies in your portfolio, and information about 
each strategy.  

Additional Information Tabs 
Additional information tabs are used to display various messages about program’s 
operation, like orders sent to server, program error messages etc. 

The additional information tabs include: 

• Signal Logs Tab: displays orders sent by your running strategies. 

• Messages Tab: displays various events in the program. 
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In order to automate your TradeStation strategy with SAS, you need to perform the 
following steps: 

• Step 1: Configure TradeStation  

• Step 2: Setup & Configure SAS  

o Test Step 1 & Step 2 

• Step 3: Setup & Configure SR Pro Console  

o Test Step 1 & Step 2 & Step 3 

 
Figure �3-1: The SAS signal processing flow  
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Configure TradeStation   
In order to enable SAS to receive signal from TradeStation and send the orders to SR 
servers/exchange, you need to configure your TradeStation as follows. Say, you have a 
strategy defined in TradeStation workspace.  First you need to configure your strategy in 
TradeStation to communicate with TradeManager. Second, you need to configure 
TradeManager to send signals (e-mail notifications) to SAS. 

Configure strategy to communicate with TradeManager 
As a first step of automation of TradeStation strategy through SAS, you need to configure 
strategy to generate orders in TradeManager. Please repeat this procedure for each 
strategy you wish to automate with SAS. 

To configure your strategy: 
1. Right click anywhere on the TradeStation chart and click Format Strategies. The 

following TradeStation Strategy properties window will appear: 
 

 
Figure �3-2: TradeStation Strategy properties window 

2. Check Generate strategy orders for display in TradeManager’s Strategy Orders 
tab. 

3. Click Close button to return to your chart. 

Configure TradeManager to communicate with SAS 
As a second step of automation of TradeStation strategy through SAS, you need to 
configure TradeManager to send signals (e-mail notifications) to SAS. To do this, you 
need to first enable e-mail notifications and then set e-mail preferences (address). 
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To enable e-mail notifications:  

1. On Tools toolbar click TradeManager button.  
2. From the View menu select TradeManager Preferences. 
3. Click Notification tab. TradeManager Preferences form will appear: 

 
Figure �3-3: TradeManager Preferences Dialog Box 

4. Check Enable e-mail notification for the following four items (as shown above); 
Strategy Active Order, Strategy Canceled Order, Strategy Filled order and Strategy 
Replaced Order  
Make sure no other item has email notification enabled. 

Setting mail preferences: 

1. Click Configure button in TradeManager Preferences Dialog Box shown above. 
Messaging Dialog Box will appear: 
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Figure �3-4: Messaging Dialog Box 

2. Fill From and To fields with any e-mail address (e.g. a@a.com, my@email.com). 
SAS does not NEED a valid e-mail address in order to receive signals.  

3. Enter “LOCALHOST” in SMTP Server name or IP address field. 
4. Click OK.  

If dialog about validating server appears click YES. Click OK to close TradeManager 
preferences form. 

Setup and configure Strategy Automation Station 
Once you’ve configured TradeStation to send signals to SAS, you now need to configure 
your SAS as follows. First you need to configure SAS to communicate with your SR 
account(s). Then, connect signals from your TradeStation Strategy through SAS to your 
SR account(s). Finally, you need to configure which contracts the strategy will trade and 
how each order will be executed (e.g. the Limit, MIT, Trailing Stops, OCO, etc).  

Once SAS is configured you need to upload it’s configuration to SR Server to enable 
proper communication between SAS and SR Server. 
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Configure SR account parameters 
As the first step of SAS configuration, you need to configure your SR account(s) 
parameters in SAS. Strategy Runner has a server-based architecture, thus SAS first sends 
each signal to SR Server and SR Server sends the trading signals to any live account(s) 
that is signed up to receive them. 

Each SR account has one corresponding SR Server with a specific Server Name and 
Naming Server parameters.  

NOTE: This information is e-mailed to you by SR team when you open an SR trading 
account. 
 
As the second step you will need to define a Vendor Name for the strategy(ies) that will 
run on your SR account(s). The Vendor Name is a name of the package under which your 
strategies are stored and displayed in your SR Console. For your convenience you can 
enter the name of your trading company (or your own name as a strategy developer) as 
the Vendor Name.  

As the third step you need to define strategy parameters to define which contract(s) the 
strategy will trade and how each order will be executed (e.g. the Limit, MIT, Trailing 
Stops, OCO, etc).  

To configure SR Account(s) in Strategy Automation Station:  

1. From the Resources menu select Accounts… The Accounts Dialog Box will appear: 

 
Figure �3-5: The Accounts Dialog Box 

2. Click New button.  
3. Enter the details as instructed in the confirmation e-mail you have received (you need 

only to do this once). 
4. Click OK. 
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To configure vendor names in Strategy Automation Station:  

1. From the Resources menu select Vendors… The Vendors Dialog Box will appear: 
 

 
Figure �3-6: The Vendors Dialog Box 

2. Click New button. 
3. Enter the Vendor Name under which your strategies will be stored and displayed in 

SR console(s). 
4. Click OK. 

To configure strategy parameters in Strategy Automation Station:  
NOTE: In TradeStation, you have to create a separate workspace for every strategy you 
wish to integrate with SAS. 

 
1. From the Strategy menu select Add Strategy… Strategy Details dialog box will 

appear: 
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Figure �3-7: Strategy Details dialog box 

2. From the Account dropdown list select the account you have just created. 
3. From the Vendor dropdown list select a vendor you just created. 
4. Fill in the Strategy name. That’s the name that will appear in SR Console in your 

portfolio. 
5. Make sure that Fills Only option is selected under Fill Style. 
6. Check TS Integration as an Integration Type of your strategy.  
7. Click TS tab and enter your TradeStation Workspace name.  

NOTE: you must enter the exact TradeStation Workspace name as it’s defined in 
TradeStation, including letter case, spaces, etc) 

8. Select contracts on which your strategy will be running. In order to do it click  
Add/Delete button, and in contracts form check the relevant contacts. 
NOTE: “(Unavailable)” means that the contract doesn’t exist on the server. 
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9. Click OK. 
 

WARNING: If you want your changes to remain next time you run SAS, you must save 
the portfolio. 

To save your modified portfolio: 
From  File menu select  Save Portfolio, 
OR 

On the toolbar, click   button. 
 

Uploading strategy parameters to SR Server 
Once SAS is configured you need to upload it’s configuration to SR Server(s) to enable 
proper communication between SAS and SR Server(s). 

To upload strategy parameters to SR Server:  

1. Click Save button from your main toolbar to save your portfolio.  
2. Click Upload button from your main toolbar to upload your portfolio to SR server(s). 

NOTE: Please wait while your strategy status in the main SAS screen in strategies table 
changed from uploading and back to idle.  

Testing of TradeStation and SAS Setups and Communication 
In order to verify that both TradeStation and SAS were successfully configured: 

1. Open Messaging Dialog Box in TradeStation (as instructed in  Figure �3-4: Messaging 
Dialog Box on page 10) 

2. Click the Test button.  
3. Click on Messages tab on the bottom half of your SAS window.  

You should see “test message received” notice. 

Setup & Configure SR Pro Console 
Once you configured TradeStation and SAS, the last step is to setup and configure SR 
Pro Console. You first need to send us an email indicating the Vendor Name you have 
entered while configuring SAS in the above section. After receiving our reply email, you 
will need to add your strategy to SR Console. Finally, you will need to run your strategy 
and observe how your signals are executing on SR Console. 

To add strategy to your individual account: 

1. Send us an email support@strategyrunner.com indicating the Vendor Name you’ve 
entered in the previous section while configuring SAS. 

2. After receiving our reply email, add your strategy to SR Console. 
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To add your TradeStation strategy into SR Console:  

1. In SR Console, add the contract that your TradeStation strategy is entering signals 
for. You can refer to Chapter 2: Managing Contracts of our User Manual in order to 
do that. 

2. In SR Console, add your TradeStation strategy. You can refer to Chapter 3: Managing 
Strategies of our User Manual in order to do that. 

NOTE: This step should be done only after receiving our reply email, indicating that your 
Vendor Name was added to your individual account (SR Console). 

Testing of Strategy Automation 
Once you configured and tested SAS/TradeStation communication, all left to do is check 
that your signals are being sent to SR Server(s) and executed/sent to your live account, 
while your account can be controlled and monitored though SR Console.  

In order to test, you will need to run your Strategy in TradeStation, SAS and SR Console 
simultaneously. 

To test automation of your strategy with SAS: 

1. Run your strategy in TradeStation. 
2. Select corresponding strategy and click Run in the SAS main window. 

Check status displays Connected… 
3. Run your strategy in SR Console and verify that your orders are being executed on 

your account. 
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 Figure �3-8: TS Tab in Strategy Details dialog box 
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In this chapter we describe how you can define different connection parameters in SAS, 
so that SAS will be able to send orders to SR Server(s) under different Vendor Names 
(package names under which your strategies are stored and displayed in your SR 
console). 

You can add, delete and edit accounts and vendors parameters.  

Adding, Deleting & Modifying Accounts  
Strategy Runner has a server-based architecture, thus SAS first sends each signal to SR 
Server and SR Server sends the trading signals to any live account(s) that is signed up to 
receive them. 

 

To add Accounts in SAS:  

1. From the Resources menu select Accounts… The Accounts Dialog Box will appear: 
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Figure �4-1: The Accounts Dialog Box 

2. Enter the details as instructed in the confirmation e-mail you have received (you need 
only do this once). 

3. Click OK. 

NOTE: This information is e-mailed to you by SR team when you open SR trading 
account. 

To edit SR Account(s) in SAS:  

1. You can change account parameters only if it is NOT used by a running strategy. 
2. From Resources menu select Accounts… The Accounts Dialog Box will appear. 

You can also edit accounts from Strategy Details dialog box on Page 13. 
3. Select account’s ID in the list of accounts’ box on the left. You'll see its details on the 

right pane.  
4. Modify account details. Each strategy in stopped/idle state which uses this server will 

be updated after you confirm the changes. 
5. Click OK. 

NOTE: If strategy on specific account is running, you can't change its properties. Stop all 
strategies, which use this account or choose another account.  

To delete SR Account in SAS:  

1. You can delete account information only if it is NOT used by any strategy. 
2. From the Resources menu click Servers… The Accounts Dialog Box will appear. 

You can also edit accounts from Strategy Details dialog box on Page 13. 
3. Select the account, and click Delete button. 
4. Click OK. 
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NOTE: If you want the deleted accounts to be excluded from your portfolio in the future, 
you must save your portfolio. 

To save your portfolio: 
• Select Save Portfolio from File menu 

OR  
• Click Save Portfolio button on the toolbar 

 

Adding, Deleting & Modifying Vendors 
As the second step you will need to define a Vendor Name for your strategy(ies). For 
your convenience you can enter the name of your trading company (or your own name as 
a strategy developer) as the vendor name.  

To add vendor in SAS:  

1. From the Resources menu select Vendors… The Vendors Dialog Box will appear: 
 

 
Figure �4-2: The Vendors Dialog Box 

2. Click New button. 
3. Enter the Vendor name under which your strategies will be stored and displayed in 

SR console(s). 
4. Click OK. 

To edit vendor parameters in SAS:  
1. You can change vendor parameters only if it is NOT used by a running strategy. 
2. From the Resources menu select Vendors… The Vendors Dialog Box will appear. 

You can also edit Vendors from Strategy Details dialog box on Page 13. 
3. Select vendor ID in the list of vendors’ box on the left. You'll see its name on the 

right pane.  
4. Modify vendor name. Each strategy in stopped/idle state which uses will be updated 

after you  confirm the changes. 
5. Click OK. 

NOTE: If there is a running strategy that uses that vendor, you can't change properties of 
the vendor. Stop all strategies which use this vendor or choose another vendor.  
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To delete vendor from SAS:  

1. You can delete vendor information only if it is NOT used by any strategy. 
2. From the Resources menu click Vendors… The Vendors Dialog Box will appear. 

You can also edit vendors from Strategy Details dialog box on Page 13. 
3. Select the vendor, and click Delete button. 
4. Click OK. 

NOTE: If you want the deleted vendors to be excluded from your portfolio in the future, 
you must save the portfolio. 
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The Strategies table in the SAS main window displays all your strategies and their status. 
You can resize or sort the table as required. 

 

Figure �5-1: The Strategies Table 

The following table describes the data displayed in each column:  

Column Heading Explanation 

Id Contract id number 

SR Strategy Name Strategy name that you see in SR Console 

3rd Party Type of 3d Party Integration (TradeStation/Excel)  

3rd Party ID TradeStation Workspace name or Feed/Order sheet 
name in Excel file 

Account Account as entered when you filled Account details 

Vendor Vendor Name 

Status Current status of the strategy 

Session ID Session ID of the strategy 

Table �5-1: The Strategies Table Explained 

Adding Strategies  

NOTE: In TradeStation, you have to create a separate workspace for every strategy you 
wish to integrate with SAS. 
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To add a new strategy: 
1. From the Strategy menu, select Add Strategy, 

 
OR 

On the toolbar, click the Add Strategy button . 
2. Strategy Details dialog box will appear:  

 

 
Figure �5-2: The Strategy Details dialog box empty 

3. Enter parameters of the Strategy as described in �Chapter 3: Quick Setup Guide in how 
to configure Strategy Parameters in SAS on Page 11. 

4. Click OK. 
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To copy an existing strategy: 
NOTE: You cannot copy  strategy on the  Running or Connected state 
 
• Right click on a strategy, which you want to copy and choose Copy strategy option, 
 
OR 
 
• Select the strategy, which you want to copy and click Copy Strategy from Strategy 

menu.  
 

NOTE: Account Name and Vendor Name are required parameters. You can add or 

modify these parameters using Manage button:   
Strategy Name is also a required parameter, however, you need to type it into the 
appropriate edit field.  

WARNING: You must change at least one of the following parameters in order to copy 
an existing Strategy (SR Strategy Name, TS Workspace Name, Account, and Vendor). 

Strategy Parameters   
To view strategy details: 
1. From the Strategy menu, select Strategy Details, 
      OR 
      From right click menu, select Strategy Details, 
      OR 
      In Strategies table, double-click the strategy name, 
 
2. Strategy Details dialog box will appear:  
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Figure �5-3: The Strategy Details dialog box filled 

No. Area Purpose 
1 Account Includes list of accounts. Select account to be 

associated with a strategy, and via which you 
are trading (supplied in confirmation email). 

2 Vendor Includes list of vendors. Select vendor to be 
associate with a strategy, and under which your 
strategy will appear in SR Console software.  

3 Strategy name Strategy name as it will appear in SR Console 
software. 

2 

1 

3 

5 

4 

6 

7 
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No. Area Purpose 
4 AutoStart 

checkbox 
Determines whether the strategy will start 
automatically when you launch SAS. 

5 Integration type Selects integration type (TradeStation, Excel, 
WealthLab or another proprietary application). 

6 Contracts List of contracts with their parameters per each 
strategy 

7 

Fill Style  

Determines your strategy behavior when a fill 
signal from TradeStation is received for one of 
its working orders. Default behavior is to react 
only on fill signals by issuing the respective 
market orders, thus, keeping you in sync with 
your TS Strategy at all times. Second option is 
Market Order. In this case, working orders 
coming from TS are situated on SR Server. 
When fill signal comes from TS, the working 
order is turned to respective market order and 
filled. 
Third and last option is Position Indicator. In 
order to use this fill style, a special indicator has 
to be placed on your TS workspace. Each time 
position changes, TS will send an indicator alert 
e-mail that is intercepted by SAS. Based on the 
contents of this e-mail SAS will update the 
current position on SR server accordingly. 
Note: you will have to request code for ‘special 
indicator’ from SR Support directly. 
 

Table �5-2: The Strategy Parameters Window Explained 

If your strategy is running, you will see all the details in read-only mode.  
If the strategy is stopped or idle, you can edit all strategy parameters (see Editing Strategy 
Parameters). 

Editing Contracts 
You can manage list of contracts for each strategy by adding and deleting them from the 
contract grid in the Strategy Parameters dialog box. You can also reset contract to its 
default settings by clicking ‘Reset All’ button displayed under ‘Contracts’ section. 

WARNING: If you want the new contracts to be included in your portfolio in the future, 
you must save the portfolio. 

To save your portfolio: 
From File menu, select Save Portfolio, 
OR 
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On the toolbar, click   button. 
 

WARNING: If you want your strategy to appear on the new contracts in SR Console you 
must upload the portfolio to server. 
 

To upload your portfolio: 
From File menu, select Upload Portfolio To Server(s), 
OR 

On the toolbar, click  button. 
 

Contracts Properties 
To view contacts details: 
1. From Strategy details window double click on selected contact, 
2. The Contract Properties dialog box will appear:  
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Figure �5-4: The Contract Properties dialog box 

Field Heading Explanation 

Start Time 

Determines when your strategy will run on our 
platform. Please consult SR Console manual 
Chapter 3: Managing Strategies for more 
information on that. 

End Time 

Determines when your strategy will stop running on 
our platform. Please consult SR Console manual 
Chapter 3: Managing Strategies for more 
information on that. 

On Error 

Determines what strategy behavior will be if an 
error occurs on SR Server. Default behavior is to 
Close strategy position, however, you can also have 
SAS transfer position to manual mode (please 
consult SR Console manual Chapter 3: Managing 
Strategies for more information on that.), OR  
ignore the error and proceed as is. 

SR trading account 

This option is used only when using SAS to route 
the orders from either Excel or another proprietary 
application. SAS will use that trading account as a 
representative in order to provide the third-party 
with order status. 

Keep positions overnight 

Determines whether your strategy is an overnight 
strategy. Please consult SR Console manual 
Chapter 4: The Manual User_Trader, Overnight 
and End Time Parameters subchapter for more 
information. 

Use maintenance pause 
Determines whether strategy will not send any 
orders at the specified time. This is used in order to 
allow for exchange maintenance pause. 

Maintenance pause start Time at which strategy stops sending orders. 

Maintenance pause end Time at which strategy resumes its operation. 

Use profit/loss safeguard Allows you to automatically stop your strategy in 
case profit or loss target (in points) are reached. 

Maximum Profit (pts) Maximum profit (in points) strategy reaches before 
immediately stopping. 

Maximum Loss (pts) Maximum loss (in points) strategy reaches before 
immediately stopping. 

Table �5-3: The Contract Properties form Explained 

To add contract:  

1. Click Add/Delete button in Strategy Details window. The Contract Properties dialog 
box (see Figure �5-4 on page 27) will appear. 
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2. Check  some contract(s) 
3. Click OK. 

To delete contract:  

1. Click Add\Delete button in Strategy Details window. The Contract Properties dialog 
box (see Figure �5-4 on page 27) will appear: 

2. Uncheck some contract(s) 
3. Click OK. 

To reset contract parameters:  

1. To Reset contract parameters to their default value by right click�Reset Selected. 
2. Click OK. 

Deleting Strategies 
If you wish, you can delete strategies from your portfolio. 

To delete strategies for a selected contract: 
Select the strategies you wish to delete. (To select many strategies, use Shift or Ctrl 
buttons). The selected strategies are highlighted. 
From Strategy menu, select Delete Strategy 
OR 

On the toolbar, click Delete Strategy button  
OR 
 

      From right click menu select Delete Selected. 
 
The deleted strategy no longer appears in your Strategy list. 

WARNING: If you want the deleted strategies to be excluded from your portfolio in the 
future, you must save the portfolio. 
 

To save your portfolio: 
From the main menu, under File, select Save Portfolio, 
OR 

On the toolbar, click Save Portfolio   button. 
 

To upload your portfolio: 
In the File menu, click Upload Portfolio To Server(s), 
OR 

On the toolbar, click the Upload Portfolio to Server(s)  button. 
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Liquidating Strategies 
The system runs strategies automatically if it is defined in their properties, according to 
their predefined start time. If you wish, you can liquidate strategies. Stopping a strategy is 
also necessary before setting lots or market direction.  
This operation will stop the strategy, cancel all working orders and close strategy position 
FOR ALL accounts that are currently running this strategy, on server for which strategy 
is defined. 

To liquidate strategy(ies): 
In Strategies table, select the strategy(ies) you wish to liquidate.  
From Strategy menu or right click menu, select Liquidate Strategy,  
      OR 

      On the toolbar, click Liquidate Strategy button , 
Confirm dialog box appears. Click Yes to proceed.  
 
The Strategies you have selected are now in liquidated status. 

Stopping Strategies 
This operation will cause SAS to stop sending any further orders to the strategy. 
 
NOTE: In order to actually cancel all existing orders you need to stop the strategy in SR 
Console. 

To stop strategy(ies) from receiving any further orders from TradeStation: 
In Strategies table, select the strategies you wish to stop.  
From Strategy menu or right click menu, select Stop Selected,  
      OR 

      On the toolbar, click Stop Strategy button . 
The strategies you have selected are now in stopped status. 

Running Strategies 
The system runs strategies automatically if AutoStart parameter is defined for them (see 
chapter 6 for details), otherwise one or multiple strategies can be initiated manually 
whenever you choose to do so. 

To run strategies: 
In the Strategies table, select the strategies you wish to run.  
In  Strategy menu select Run Strategy or from right click menu select  Run Selected 
      OR 

      On the toolbar, click Run Strategy button . 
The strategies you have run are now in connecting or connected status. 

NOTE: The strategies you have run will enter running status when they receive any 
signal from TradeStation.  
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Setting Strategy Position Count 
You can manually choose to set the position for all subscribers (e.g., SR Consoles) on a 
specific server. 

To set strategy position for specific server: 
1. In the Strategies table, select strategy you wish to set position count for.  
2. From  Strategy menu select Set Strategy Position Count or from right click menu 

select  Set Strategy Position Count. 
3. In Set Position Count box that follows, select contract and position you wish to set 

all subscribers (e.g., SR Consoles) to. 
4. In SR Console, check that strategy was set to the appropriate position. 

NOTE: This procedure has to be done ONCE for every strategy/server you wish to set 
the position for.  
 

Sending a Test Signal 
You can send a test signal from SAS to SR Console in order to check their 
communication with one another. 

To send a test signal: 
1. In the Strategies table, select strategy you wish to send a test message for.  
2. From Strategy menu select Send Test Signal or from right click menu select Send 

test signal. 
3. In Set Position Count box that follows, select contract and position you wish to set 

all subscribers (e.g., SR Consoles) to. 
4. In SR Console, under Messages Tab, check that a test message was received. 
 

Downloading and Uploading Portfolio  
To download portfolio from server: 
• In File menu, click Download Portfolio from Server(s). 

 
       OR 

• On the toolbar, click Download Portfolio from Server(s) button .  

To upload portfolio to server: 
• In the File menu, click Upload Portfolio to Server(s). 
 
      OR 

• On the toolbar, click Upload Portfolio to Server(s) button .  

NOTE: During downloading/uploading all portfolio and resources actions are 
unavailable. 
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WARNING: When you upload your portfolio you are erasing your old portfolio if you had 
one before. 
 
WARNING: Stop all strategies before using Download Portfolio from Server(s) option. 
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General Settings  
 
You can setup SAS to automatically display live updates of new version releases in order 
to always stay in sync with SAS latest developments.  You can also set SAS to warn you 
whenever your strategy auto starts and schedule SAS to shut down automatically at a 
predefined time. Finally, you can set SAS to display Sound Alerts, on display of new 
messages or in the case trading signal has been lost. 
 
 

               
Figure �6-1: The system settings General Tab dialog 
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Table �6-1: The system setting General Tab dialog explained 

Checkbox Heading Explanation 

Inform about optional updates Show notification about updates which are optional 
(not obligatory). 

Confirm strategy auto start 
Enable/disable confirmation window informing 
about strategy(ies) that will be started 
automatically. 

Exit Automatically Enable/disable SAS automatic shutdown at 
predefined exit time. 

Exit time Time at which SAS will be shutdown automatically. 

On new message Enable/disable voice signal alert whenever new 
message is generated in SAS Message Tab. 

On signal lost due to connection 
problems 

Enable/disable voice signal alert whenever SAS 
looses connection with SR Server(s). 

NOTE: If the Confirm strategy auto start is disabled, these strategies will be started 
anyway when you launch SAS.  

TS Mail Settings 
These settings can help you troubleshoot communication between SAS and TradeStation. 
Using these settings, you can also enable transmission of the trading signals (coming 
from your TradeStation strategies) to your personal email account. 
Finally, you can configure SAS to send e-mail notifications to you, each time a trading 
signals is lost, due to network error on one of SR Server(s). SR Support team will also be 
notified at the end of the SAS run.  
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Figure �6-2: The system settings mail tab dialog 

Table �6-2: The system settings mail tab dialog explained 

Field Heading Explanation 

Communication latency Increase this value if you are missing signals from 
TradeStation 

Enable notification via 
pass through e-mailing 

Enable/disable e-mail notification about unsent 
signals. 

Error notification 
frequency (min) 

Frequency of which run-time notification e-mails 
will be sent (defaulted to one minute) 

Enable pass through e-
mailing 

Send all signals received from TradeStation to a 
specified mail address using specified mail server. 

"To" e-mail address Address to which you want all the signals to be sent 
when they arrive from TradeStation. 

"From" e-mail address Address from which it will appear email was sent. 

Using e-mail Server Specify mail server that you use for sending emails. 

  

WARNING: This may not work with some email servers (ISP’s), especially servers 
requiring email authentication. 
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NOTE: Check your email client settings or ask your Internet Service Provider to obtain 
this information. 

SR Server Settings  
Settings in this TAB determine timeout values for connection with server. 
Usually you shouldn’t change these settings. If SAS often stops responding while 
connecting to server(s), you can lower values in these settings for better performance. 

 

Figure �6-3: The system settings SR Server tab dialog 

Table �6-3: The system settings SR Server tab dialog explained 

Field Heading Explanation 

Connection Timeout 
Time allowed for SAS to connect to the server. If at 
the end of this period connection wasn’t 
established, a failure to connect is declared 

Order Timeout 

Time allowed for SAS to send an order to the 
server. If not immediately successful, SAS will try 
several times to send an order. If at the end of this 
period the order still wasn’t sent, it is considered a 
failure. 

 Special Symbols  
 
Trade Station may be using special contract symbols (e.g., @ER2.D, @ER.P) for the 
origination of its orders. You can need to setup SAS in order to process Trade Station’s 
trading signals accordingly. 
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To setup special symbols in SAS: 
1. From Settings menu choose Special Symbols, click New. 
2. In Symbol Properties box that follows, set TS symbol value in Special Symbol 

AND 
set standard symbol (which will be sent from SAS to SR Server ) value in Standard 
Symbols. 

 
 Figure �6-4: The Symbol Properties box 

 
 
3. When done, click Apply and OK. 

 
 Figure �6-5: The Special Symbols tab dialog 
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Sending a Problem Report 
You can send out a problem report to SR Support team for observation. 
 

To send out a problem report: 
1. From Help menu choose Problem Report 

OR 

On the toolbar, click Problem Report button. 
2. In Problem Report box that follows, set the Report Period you wish to send for 

observation. 
3. Select Account you wish to send for observation. 
4. In Short and Long Problem Description specify subject and content of your problem 

(including date/time problem occurred) respectively. 
5. To send, click OK. 
 
 

 
 
 

 
Figure �6-6: The Problem Report tab dialog 
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Appendix: SAS Client Side API 

General Description 
 
Strategy Runner (SR) Client Side (CS) API is an integral part of SR Strategy Automation 
Station (SAS). Its purpose is to provide easy to use interface that allows trading system 
developers to have complete control over their strategies. 
 
CS SR API is thread safe and can be used in complex multi-threaded environment. 

Integration Overview 
Depending on the framework you used in order to develop your trading system, you can 
integrate with one of the following SR CS API extensions: 

• Regular DLL – This is suitable for programming languages such as C or C++. 
Your program would load standard Windows DLL and call functions from 
within that DLL 

• COM – This may be an optimal solution for integration with Visual Basic. Your 
program would establish connection to a COM object published by the API and 
call member functions of that object.  

• OLE COM –This extension is suggested for integration with the system based 
on Visual Basic for Applications (VBA) or any other system that requires OLE 
compatibility. Similarly to COM extension above your program would 
communicate with a COM object published by the API. 

• JAVA JNI – if your program is written in Java, SR CS API provides you with 
set of convenient classes and methods that will allow seamless integration with 
your code. The methods of the API are implemented in C++ under JNI. 

Distribution 
You can find files necessary for your specific extension under C:\Program 
Files\StrategyRunner\TSSR\src\. There are sub-directories in that location: 

• \C\ - represents the .H file you need to #include to your code in order to get all 
the necessary declarations. 

• \COM\ - represents both COM and OLE COM IDL declarations and 
supplementary .H file with the definitions of data structures used by the API. 

• \Java\WinTSSRAPI\ - represents .java files with the definitions of data 
structures and methods used by the API. 

Whichever extension you choose for your particular integration, the source files in \src\ 
directory are essentially self-explanatory. Additionally, we provide detailed description 
of data structures and methods exported by the API in our complete CS API documents. 
Please let us know (email: support@strategyrunner.com) shall you require more 
information about Strategy Runner Client Side API. 

 


